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Abstract

Today’s automobile industry is doing a good amount of work in developing gadgets and applications

which provide safety, comfort and experience to the users. Audio system is one among them and

music has become a part of our day-to-day life.

The current research work aims at providing appropriate car audio tuning parameters that suits

the requirements of Indian customers by taking into account Indian culture, quality of sound, psycho-

acoustic and engineering parameters. As the music/audio will be mostly described in qualitative

manner, the main challenge here is to translate this information into engineering parameters. A

methodology is developed to study the car audio system. Objective and subjective tests have been

conducted and the results were compared to get the appropriate tuning parameters.

This project also provides the acoustic simulations inside a car interior using a combined Finite

Element (FE) and Geometric Acoustics (GA) approach. The simulations are conducted for the

whole audible frequency range using the loudspeakers of the car audio system as the source. It also

focuses on the acquisition of the boundary and source data required for the simulation. Straight

forward determination of this data is not possible because of the complexity and inhomogeneity of

the materials and loudspeaker configurations. Different methods were applied to determine required

data for various materials and loudspeaker configurations inside a car compartment. In order to

keep the complexity of FE simulations at a manageable level, all passive boundary conditions were

considered. the outcome of these simulations are identification of the ”Hotspots” which indicates

about the audio quality in the low frequency region and various psycho-acoustic parameters like

Initial Time Delay Gap (ITDG), Inter-aural cross correlation (IACC) and Binaural Quality Index

(BQI) that describes about the audio quality in the high frequency region.
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Chapter 1

Introduction:

The way a listener determines the sound quality of a product is a very complex phenomenon. The

perceived quality results from a comparison process in which the subject assesses what is actually

presented to him with respect to a ”desired” stimulus. For example, the best sound quality rating

is reached when the system under test fulfil the listener’s expectations. Moreover, for the quality

assessment relies not only on the system under test itself but also on numerous external factors such

as the stimulus type, background noise and the listening environment as these parameters could

modify the way it is perceived and affect the sound quality.

1.1 Problem statement:

The tuning of car audio system was done taking the global music scenario into consideration. The

challenge here is to find acceptance of global settings for local market. The current project aims to

find evaluation procedure and develop target curves for Indian Market.

1.2 Literature survey:

Literature study aims at finding out the factors that effect the quality of sound inside the car. The

main factors are -

1. Back ground noise

2. Cognitive effects

3. Listening environment

4. Sound generation by the audio system

1.2.1 Back ground noise:

Back ground noise plays an important role in determining the quality of sound inside the car. The

back ground noise in a car is usually because of the noise from the engine, traffic outside, interaction

between the wheel and road, etc., The car is in stationary condition (engine is off) while the sound

1



pressure levels were measured inside the car. Hence, the effect of back ground noise on the sound

inside the car can be minimized.

1.2.2 Cognitive effects:

As the sound is judged by normal people (here customers) in terms of quality, subjective tests are

needed to be performed. But in the case of subjective tests the test environment plays an important

role. So, it is important to maintain same type of test environment for all the subjects. In this way,

the cognitive effects are also minimized.

1.2.3 Listening environment:

In sound quality of car audio problem, the listening environment is car interior. Compared to a

normal listening room, a car compartment is a very special sound field. As the car compartment

has only around 3m3 of space and is full of sound absorbing objects such as seats, carpet and roof

treatment. So, reverberation of sound is very little [1]. On the other hand, as the reflective objects

such as glass windows are close to speakers in a car compartment, naturally there are large early-

reflected sounds close to the direct sound. Listeners feel the reflected sounds as the changed timbre

of direct sounds, not as reverberation of sounds. The problem is worsened by the non-uniformity of

sound pressure levels across the seating positions inside the car compartment.

To characterize the car interior [2] certain parameters are to be measured. They are Sound levels

inside the car, Spaciousness and Localization, Impulse response (IR) function for various seating

positions, Reverberation time and Transfer function between speaker and listener.

Spaciousness and Localization: Both are perceptual attributes. ”Spaciousness” [3] refers to

the perceived size of the sound source and how much you feel enveloped with sound. The main

contributing factors for spaciousness are ”early lateral reflections”.

”Localization” [3] refers to the ability to detect the direction of a specific sound source. It is

almost entirely determined by the direction of the first arrival of sound ( almost always the direct

sound from the speaker in this case) and thus is almost entirely immune from the effects of reflections.

Inter-aural Level Difference (ILD) and Inter-aural Time Difference (ITD) [1,4] are the parameters

required to know the spaciousness and localization.

ITD is described as - sound from right side reaches the right ear earlier than the left ear. The

human auditory system evaluates inter-aural time differences from Phase delays at low frequencies

and Group delays at high frequencies.

ILD is described as - sound arrives from the right side has a higher level at the right ear than at

the left ear, because the head shadows the left ear. These level differences are highly frequency

dependent and they increase with increasing frequency.

For frequencies below 800Hz, mainly inter-aural time differences are evaluated (Phase delays),
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for frequencies above 1600Hz mainly inter-aural level differences are evaluated. Between 800Hz and

1600Hz there is a transition zone, where both mechanisms play a role.

Evaluation for low frequencies: For frequencies below 800Hz , the dimensions of the head

(Approximate distance between two ears is 21.5 cm, corresponding to an inter-aural time delay of

625 µs), are smaller than the half wavelength of the sound waves. So, the auditory system can

determine phase delays between both ears without confusion. Inter-aural level differences are very

low in this frequency range, especially below about 200Hz [1,4], so a precise evaluation of the input

direction is nearly impossible on the basis of level differences alone. As the frequency drops below

80Hz, it becomes difficult or impossible to use either time difference to determine a sound’s lateral

source, because the phase difference between the ears becomes too small for a directional evaluation.

Evaluation for high frequencies: For frequencies above 1600Hz the dimensions of the head

are greater than the length of the sound waves. An unambiguous determination of the input direc-

tion based on inter-aural phase alone is not possible at these frequencies. However, the inter-aural

level differences become larger, and these level differences are evaluated by the auditory system.

Also, group delays between the ears can be evaluated, and is more pronounced at higher frequencies;

that is, if there is a sound onset, the delay of this onset between the ears can be used to determine

the input direction of the corresponding sound source [1, 4]. This mechanism becomes especially

important in reverberant environments. After a sound onset, there is a short time frame where the

direct sound reaches the ears, but not yet the reflected sound. The auditory system uses this short

time frame for evaluating the sound source direction, and keeps this detected direction as long as

reflections and reverberaion prevent an unambiguous direction elimination.

The mechanisms described above cannot be used to differentiate between a sound source ahead

of the hearer or behind; therefore additional cues have to be evaluated.

Sound localization in the median plane (front, above, back, below):

Monoaural cues: The human outer ear, i.e. the structure of the Pinna and the external ear canal,

form direction-selective filters. Depending on the sound input direction in the median plane, differ-

ent filter resonances become active. These resonances implant direction-specific patterns into the

frequency responses of the ears, which can be evaluated by the auditory system (directional bands)

for vertical sound localization [1]. Together with other direction-selective reflections at the head,

shoulders and torso, they form the outer ear transfer functions.

Dynamic binaural cues: When the head is stationary, the binaural cues for lateral sound

localization ( ITD and ILD ) [1] do not give information about the location of a sound in the median

plane. Identical ITDs and ILDs can be produced by sounds at eye level or at any elevation, as

long as the lateral direction is constant. However if the head is rotated, the ITD and ILD change

dynamically, and those changes are different for sounds at different elevations. If the presentation

of binaural cues to the two ears during head movement is reversed, the sound will be heard behind

the listener.
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Impulse Response(IR) function for various seating positions: In acoustic and audio

applications, impulse responses are used to identify the acoustic characteristics of any closed envi-

ronment.

Reverberation time: Reverberation is the persistence of sound after a sound is produced.

Reverberation is frequency dependent: the length of the decay, or reverberation time [5], receives

special consideration in the architectural design of spaces which need to have specific reverberation

times to achieve optimum performance for their intended activity.

The time it takes for energy of a signal to drop by 60dB is the reverberation time, denoted by

RT60. The optimum reverberation time for a space in which music is played depends on the type of

music that is to be played in the space. Rooms used for speech typically need a shorter reverberation

time so that speech can be understood more clearly. If the reflected sound from one syllable is still

heard when the next syllable is spoken, it may be difficult to understand to what was said. If on the

other hand the reverberation time is too short, tonal balance and loudness may suffer. Reverberation

changes the perceived spectral structure of a sound, but does not alter the pitch.

Basic factors that affect a room’s reverberation time include the size and shape of the enclosure

as well as the materials used in the construction of the room. Every object placed within the enclo-

sure can also affect the reverberation time, including people and their belongings.

1.2.4 Car audio system:

Car audio system comprises of audio player and loudspeakers. The characteristics of these two have

a good impact on the sound inside the car.

Audio Player: The audio player is characterized by it’s tuning settings / equalizer settings [6]

across different frequency bands. The tuning settings represent the gain in sound pressure levels

given for various frequency bands.

Equalizers: Equalizers are an essential part of any sound reproducing system. They have many

applications for various users. An equalizer is a filter that allows a person to control the tone (fre-

quency response), of a sound system. The equalizer itself does not manipulate sound or sound waves.

Knowing how an equalizer works is not absolutely necessary to operate one. However, it can help

in making accurate judgements about them.

Loud Speakers: A loudspeaker is an electro-acoustic transducer, a device which converts an

electrical audio signal into a corresponding sound. The most widely used type of speaker today

is the Dynamic speaker. The dynamic speaker operates on the same basic principle as a dynamic

microphone, but in reverse, to produce sound from an electrical signal. When an alternating current

electrical audio signal is applied to it’s voice coil (a coil of wire suspended in a circular gap between

the poles of a permanent magnet), the coil is forced to move rapidly back and forth due to Faraday’s

law of induction. The one end of the voice coil attached to a diaphragm also moves back and forth
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pushing the air to create sound waves. The sound source (e.g., a sound recording or a microphone)

must be amplified with an amplifier before the signal is sent to the speaker.

Speakers are typically housed in an enclosure which is often a rectangular or square box made

of wood or sometimes plastic, and the enclosure plays an important role in the quality of the sound.

Where high fidelity reproduction of sound is required, multiple loudspeakers are often mounted in

the same enclosure, each reproducing a part of the audible frequency range. In this case the individ-

ual speakers are referred to as ”drivers” and the entire unit is called a loudspeaker. Drivers made

for reproducing high audio frequencies are called ”Tweeters”, those for middle frequencies are called

”Mid-Range drivers”, and those for low frequencies are called ”Woofers”.

Subwoofer: A subwoofer is a woofer driver used only for the lowest part of the audio spectrum:

typically below 200Hz for consumer systems, below 100Hz for professional live sound. Since sound

in this frequency range can easily bend around corners by diffraction, the speaker aperture does not

have to face the audience, and subwoofers can be mounted in the bottom of the enclosure, facing

the floor.

Woofer: A woofer is a driver that reproduces low frequencies. The driver combines with the

enclosure design to produce suitable low frequencies. Some loudspeaker systems use a woofer for

the lowest frequencies, sometimes well enough that a subwoofer is not needed. Additionally, some

loudspeakers use the woofer to handle middle frequencies, eliminating the mid-range driver. This

can be accomplished with the selection of a tweeter that can work low enough that, combined with

a woofer that responds high enough, the two drivers add coherently in the middle frequencies.

Mid-Range driver: A mid-range speaker is a loudspeaker driver that reproduces middle fre-

quencies. Mid-range driver diaphragms can be made of paper or composite materials, and can be

direct radiation drivers (rather like smaller woofers) or they can be compression drivers (rather like

some tweeter designs). If the mid-range driver is a direct radiator, it can be mounted on the front

baffle of a loudspeaker enclosure, or, if a compression driver, mounted at the throat of a horn for

added output level and control of radiation pattern.

Tweeter: A tweeter is a high-frequency driver that reproduces the highest frequencies in a

speaker system. A major problem in tweeter design is achieving wide angular sound coverage (off-

axis response), since high frequency sound tends to leave the speaker in narrow beams.

The terms for different speaker drivers differ, depending on the application. In two-way systems

there is no mid-range driver, so the task of reproducing the mid-range sounds falls upon the woofer

and tweeter. Home stereos use the designation ”tweeter” for the high frequency driver, while pro-

fessional concert systems may designate them as ”HF” or ”highs”.

Crossover: When multiple drivers are used in a system, a ”filter network”, called a Crossover,

separates the incoming signal into different frequency ranges and routes them to the appropriate

driver. The drivers receive power only in their usable frequency range (the range they were designed
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for), thereby reducing distortion in the drivers and interference between them. A loudspeaker system

with n separate frequency bands is described as ”n-way speakers”: a two-way system will have a

woofer and a tweeter; a three-way system employs a woofer, a mid-range, and a tweeter.

Loudspeakers can be characterized by their SPL measurements, FRF measurements, Directivity

and Total Harmonic Distortion(THD).

Directivity: Directivity of a loudspeaker [7] describes about the direction in which the loud-

speaker is emitting maximum sound pressure level.

Frequency Response Function:Frequency response [7] is the quantitative measure of the

output spectrum of a system or device in response to a stimulus, and is used to characterize the

dynamics of the system. It is a measure of magnitude and phase of the output as a function of

frequency with respect to the input. In simplest terms, for a given sine wave, a linear system will

respond at that same frequency with a certain magnitude and a certain phase angle relative to the

input.

Frequency response curves are often used to indicate the accuracy of electronic components or

systems. When a system or component reproduces all desired input signals with no emphasis or

attenuation of a particular frequency band, the system or component is said to be ”Flat”, or to have

a flat frequency response curve.

Total Harmonic Distortion(THD): THD of a signal is a measurement of the harmonic dis-

tortion [7] present and is defined as the ratio of the sum of the powers of all harmonic components

to the power of the fundamental frequency.

THD =
√

(H2)2 + (H3)2 + ....+ (Hn)2)/H1 (1.1)

THD =
√

(H2)2 + (H3)2 + ....+ (Hn)2)/H1

H2, ....Hn = Power levels of the harmonics

H1 = Power level of the fundamental tone

THD is used to characterize the linearity of audio systems and the power quality of electric power

systems.

In audio systems, lower distortion means the components in a loudspeaker, amplifier or micro-

phone or the other equipment produce a more accurate reproduction of an audio recording.
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1.3 Room acoustic simulations of car audio systems in car

passenger compartments

Any kind of room acoustic simulation requires an appropriate geometric model and suitable mathe-

matical models for sound radiation, reception and boundary conditions such as absorbing materials,

sound reflections at room boundaries and sound reception. So does the car interior acoustic simu-

lation. The quality and accuracy of the simulation is dependent on the accuracy of these models

and their input data. Using the present day available designing and analysis tools a high quality

geometric model of a car interior can be established and the boundary and source conditions can be

accurately represented. However, it is important to note that the commonly applied source, bound-

ary and reception models vary considerably depending on the underlying sound field model(e.g. FEM

and GA). Moreover, while determining the acoustic boundary conditions using different methods for

different types of materials, a lot of uncertainties arise. But the combination of all these methods

and the best choice of a specific method for the boundaries and materials in a car compartment is

to be well studied considering the applicability and uncertainty into the final sound pressure field

and auralization. For both boundary and source conditions, the analysis is structured into two parts

which deal with the following [8] -

(1) Which data is required in FE and GA domain and how does the different input data in both

domains relate to each other?

(2) What are the conclusions from the results and their uncertainties in the case of the car materials

and loudspeakers?

1.4 Establishment of a geometric model

Establishing a proper geometrical model is quite necessary for a simulation of sound field by the

loudspeakers inside the car passenger compartment. Generally, it is possible to simulate in the low

frequency range using FEM or BEM approach. Geometrical Acoustic Method based on ray trac-

ing is used in the mid-to-high frequency range to simulate wave propagation in the car interior.

However, the car passenger compartment [9] is a highly difficult simulation environment as com-

pared to a normal listening room. This has many reasons. Firstly, the car interior is not designed

with the primary intention of good acoustics. Relatively very few priori information exists on the

acoustic characteristics of the boundary materials and sound sources in the car. The most impor-

tant reason is that the car materials are mostly not accessible to a straight forward determination

of their acoustic characteristics, due to curved shapes and highly inhomogeneous material structures.

The Geometrical acoustics simulation faces limitations caused by (a) various diffraction edges

at the front seats and head rests, (b) high geometrical details and complex, curved shape of many

boundary surfaces and (c) close vicinity of sound source and receiver to each other as well as to

surrounding boundaries which is a limitation for the Image source method (ISM) and the Stochastic

ray tracing method (SRT).
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1.5 Boundary conditions

The boundary conditions in this project refers to the passive boundary surfaces that comprises of

inner lining of the car interior [8]. This includes the car floor carpet, seat cushion material, glass

windows etc., . The acoustic reflection characteristics can be described by giving suitable coupling

conditions between the fluid and the structure domain. The fluid in the car interior is air. As

the boundary conditions are passive, weak coupling condition is given to model acoustic reflection

characteristics. Acoustic absorption characteristics can be described by modelling the absorption

materials using various models as per the type of the material.

1.5.1 Required boundary data:

FE domain

The acoustic surface impedance can sufficiently define the physical behaviour of the boundary

wall [8]. Following Mechel’s empirical expressions [10], the general type of boundary condition

at the interface of two inviscid fluids can be modelled by considering that the sound pressure and

the surface normal velocity are continuous across the boundary. Value of surface impedance is given

by Zs = p
vn

. However, these equivalent formulations are more like ”coupling conditions” rather

than ”boundary conditions” as they are not independent of the sound field in front of the boundary.

However by assuming that the propagation of sound occurs only in the perpendicular direction to

the boundary surface, the behaviour of an acoustic boundary can be described solely by its acoustic

surface impedance Zs, which is independent of the incident sound field. Such boundaries are called

”locally reacting” as the surface normal velocity vn at a point is dependent only on the sound pres-

sure p at that point and is independent of the surrounding pressure distribution. This approximation

is not true for elastic plates as the adjacent materials are coupled by their bending stiffness. However

this approximation is admissible in case of porous absorber materials only if the absolute value of

the their propagation constant is much higher than that of the air.

Hence the impedance boundary approach in the FE domain neglects possible coupling effects

caused by the structural vibrations of the car. However, these effects are only considered to signifi-

cantly effect the room sound field only in the low frequency range, as there will be a strong modal

coupling between fluid and structural waves.

GA domain

In geometrical acoustics simulations the reflection characteristics of the room boundaries are gener-

ally modelled by assigning the diffuse-field absorption coefficient αdiff and scattering coefficient s

to each boundary. Unlike the wave-based frequency domain models the geometrical models require

these data as frequency band averages (octaves or third-octaves). With regard to the absorption

characteristics at the boundary this means that both the phase shift at the boundary reflection as

well as the angle dependence of the reflection coefficient are neglected in typical GA simulations.

This simplification is generally admissible atleast for the late part of the impulse response.
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Unlike the absorption coefficient he determination of scattering coefficient can be done with a

huge simplification of the scattered process that it applies only to ideally diffuse reflecting surfaces.

More accurate representation of scattering process can be done by considering all angles of incidence

on a hemisphere for all considered frequency bands. For room acoustic simulations where a large

number of surfaces are to be characterized, such a measurement effort is infeasible.

1.5.2 Boundary conditions for Car materials

In order to specify boundary conditions for the FE and GA domains [8], the acoustic impedances

and absorption coefficients are required for the car interior materials. The car interior materials

under consideration are seat cushions, floor carpet and windows. Each of these are a combination

of different types of materials and have different boundary conditions.

Car seat cushions

Car seats are made up of complex and inhomogeneously layered material configurations, consisting

of a leather or fabric cover, a metal frame, multiple porous layers, a plastic back lining and in some

cases of high-class vehicles even heating, ventilation or massage units [8]. The car seat cushions con-

sidered in this project have a fabric seat cover, three types of porous materials of different thickness

and a plastic back lining which provides rigid termination.

Car floor carpet in foot space

The leg room in the front and back of the car is lined with a porous floor carpet with a thin airtight

backing which is glued to a heavy foam of inhomogeneous thickness which is formed to fit into the

underlying sheet metal structure [8]. In the floor areas this carpet is mostly covered with additional

car mats, which are similarly made of a porous fabric with a stiff porous backing.

Windows

The glass windows in the car [8] can be considered as almost acoustically rigid except for the lowest

frequency bands. The windows were modelled as a surface mass m′ with a free-field termination Z0:

Zs = jωm′ + Z0 (1.2)

A low frequency approximation exists to correct the surface mass term m′ for coincidence effects.

The effective surface mass m′eff is in this case given as a function of the angle of incidence θ0 ):

m′eff = m′[(1− (
f

fcr
)2sin4 θ0)− j(η(

f

fcr
)2sin4 θ0))] (1.3)
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where fcr is the critical frequency of the considered elastic plate. According to Mechel, these formulas

are however only valid up to frequencies which lie at least half an octave below fcr.

fcr = 2000

√
RT60
V

Hz (1.4)

where RT60 is the Reverberation time and V is the volume of the car compartment. For the con-

sidered glass windows fcr is 3kHz the mass correction was only applied in the calculation of the

surface impedance for the FE frequency range. The absorption characteristics for the GA frequency

domain were calculated the surface mass jωm′ which gives an approximately rigid behaviour of the

windows in GA frequency domain.

1.6 Source conditions

As this project focuses on the sound field in the car compartments which is excited by the car

audio system, it is important to model the sound emission from the loudspeaker sound sources [8].

These sources can be modelled independent of the input signal by considering their free field transfer

function in the main direction of radiation and their directivity pattern. This section deals with the

method of obtaining necessary loudspeaker data for simulation purpose for both FE and GA domains.

1.6.1 Required source data in FE and GA domain

In the FE domain, loudspeaker sound source can be modelled by assigning the surface normal ve-

locity vn to the loudspeaker diaphragm membrane i.e., boundary surface τv where vn is the surface

normal membrane velocity. This source representation requires a full model of the loudspeaker in

it’s actual built-in situation. The directional characteristics of loudspeaker source are mostly caused

by diffraction at the loudspeaker cabinet and in case of a multi-channel loudspeaker interference be-

tween the different driver membranes, such a model of the driver units (membranes) in their built-in

situation could capture the directivity characteristics of the loudspeaker. Thus for FE domain, a

spatial and frequency dependent scan of membrane velocity of each loudspeaker is required.

In GA domain, the loudspeakers are modelled as point sources from which sound rays are emitted

into multiple directions in the room. In order to model the directional and frequency characteristics

of a real sound source, it is thus necessary to suitably adjust the spherical energy distribution of the

emitted sound rays in all considered frequency bands. This can be done by measuring the directivity

function of the considered sound source, which gives the directional frequency characteristics of a

source relative to it’s principle direction.

1.6.2 Determination of source data

By taking the advantage of the radial symmetry of most loudspeakers drivers the directivity can be

determined by measuring the pressure responses on a quarter circle. Laser Doppler Vibrometer is
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used in order to obtain the necessary source data for the room acoustic FE simulations.

As an alternative to the direct measurement of the loudspeaker membrane velocity [8], an elec-

trical analogy network was used to model the low frequency performance of a loudspeaker and thus

determine it’s diaphragm velocity and radiated sound power as a function of the input voltage at the

voice-coil terminals. The parameters used for this network model are widely known as ”Thiele-Small”

parameters [11–13]. It is important to note that electrical analogy network model is applicable in

the ”piston range” of a loudspeaker. This is because at higher frequencies it is no longer suitable to

model the mechanical and acoustical part of the loudspeaker by the lumped components as used in

the network diagram which was presented in the next section. This is because the loudspeaker and

it’s suspension can no longer be approximated as an ideal piston with a damped spring suspension,

due to the formation of eigen modes on the loudspeaker diaphragm.

In the next step, the measured or calculated membrane velocities vm(f) at the voice cols were

then used to predict the on-axis free field pressure transfer function at 1 m under the assumption

that the loudspeakers work as ideal piston sources in infinite baffle.

On the other hand, in case of room acoustic GA simulations, this model can only be used with

considerable precaution, that the prediction of the free field pressure transfer function for the mid-

and high- frequency range contains non-negligible simplifications and that the model gives no indi-

cation about the directional characteristics of the loudspeaker system.

1.7 Structure of the report:

Chapter 1 is the project introduction which discusses the problem statement, literature survey for

the target curves and acoustic simulations. Chapter 2 describes the modelling of a loudspeaker

using an electrical analogy and thereby calculating the loudspeaker membrane velocities.Chapter

3 describes the modelling of porous materials using the laws of Delany and Bazely. These porous

materials are used extensively inside the car. Chapter 5 describes the methodology adapted and

implemented for the performing objective tests and subjective tests. It also discusses the simulation

methods, tools and settings. Chapter 6 presents and discusses the results obtained by following the

methodology discussed in chapter 5. It presents the Target curves which are outcome from subjec-

tive and objective tests. It also presents the simulation results from both Finite element (FE) and

Geometric Acoustic (GA) domains. Chapter 7 summarizes the entire project and gives a scope of

extending the work further.

11



Chapter 2

Loudspeaker modelling: Driver

parameters and Equivalent

diagrams

This section discusses about the modelling of the loudspeaker.

2.1 Loudspeaker Driver Construction

The idea of a loudspeaker driver is to move air by sending alternating electrical current through a

coil positioned in a magnetic field and connected to a membrane. The schematic of the loudspeaker

is shown in the Fig.2.1.

The magnet and the pole piece are used to create a magnetic field in the air gap. When an

alternating current is sent through the voice coil, it will make the voice coil and the membrane

attached to it move according to the frequency. The spider is used to keep the voice coil centred

in the air gap, and keeping it from touching the magnet and the pole piece. The spider and the

suspension is responsible for introducing mechanical resistance and compliance to pull the membrane

back to it’s resting position. The compliance together with the mass create a resonance frequency.

The membrane, the dust cap and part of the suspension are the parts of the loudspeaker that moves

the air. It is responsible for giving a better coupling to the air to more efficiently convert movements

of the voice coil to movement of air. Furthermore the dust cap and the spider has to protect the air

gap against dust.

2.2 Loudspeaker parameters

Voice coil resistance, Re The voice coil resistance is the part of the voice coil impedance that is

resistive. It is measured in Ω.
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Figure 2.1: Cross-section of electrodynamic loudspeaker driver

Voice coil inductance, Le The voice coil inductance is the part of the voice coil impedance

that is reactive. It is measured in Henry.

Voice coil inductance correction factor, n The voice coil correction factor n is included to

have a better model of how a lossy inductor behaves. The correction factor is used as shown in the

equation-

jωLe → (jω)nLe (2.1)

where n is a value between 0 and 1. When using the correction factor, the size of the inductance

has to be adjusted.

Moving mass, Mm The moving mass is the weight of the membrane assembly. This includes

the membrane, the dust cap, the voice coil and partly the suspension and the spider. This mass

does not include the air that moves along the driver. The moving mass is measured in Kg.

Mechanical resistance, Rm The mechanical resistance is formed by the suspension and the

spider of the driver. It is the part of the drivers mechanical impedance that is resistive. the me-

chanical resistance is measured in Ns
m .

Mechanical compliance, Cm Mechanical compliance is formed by the suspension and the spi-

der. it is the part of the mechanical impedance that is reactive. it is responsible for pulling the

membrane back to it’s resting position after excitation. the mechanical compliance is measures in m
N .

Force factor, Bl The magnetic force is the product of the magnetic flux in the air gap, and

the length of the wire in the voice coil. This describes the strength of the loudspeaker motor. The

magnetic force factor is measured in N
A .
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2.2.1 General equivalent diagram

The parameters can be used to make a model of a loudspeaker. The model consists of three parts

describing the electrical, mechanical and acoustical part of the driver [14].

Electrical components The electrical part can be directly derived from knowledge of the

construction of a driver. It consists of a coil and a resistor in series connection. It can be see in

Fig.2.2

𝐿𝑒 𝑅𝑒

𝐼

Figure 2.2: Equivalent diagram of the electrical part of the loudspeaker

Therefore, the electrical impedance is given by -

Ze = Re + (jω)nLe (2.2)

Mechanical components The mechanical part of the model includes the moving parts of the

system. That is the membrane assembly, the spider and the suspension. The weight of the moving

parts Mm multiplied with the acceleration of the membrane dvn/dt describes the force acting on the

membrane. vn is the surface normal velocity of the membrane. The spider and suspension act as a

spring with a total compliance Cm. When the membrane is moved out of its resting position, this

spring will pull the membrane to the resting position with a force of (1/Cm)
∫
vndt, where

∫
vndt is

the displacement of the membrane.

There is a mechanical loss Rm. This arises when movement is converted into heat in the suspen-

sion and spider of the driver. All the mechanical parts act as forces on the membrane, and they can

be added together:

vn.Zmech =
∑

externalforces = Mm
dvn
dt

+ rmvn +
1

Cm

∫
vndt (2.3)

Laplace transformed:

∑
externalforces = sMmVn + rmVn +

1

sCm
Vn (2.4)

The external forces is the magnet motor force,BlI. From the Laplace transformed equation it can

directly be seen, that an electrical analogy should consist of a series connection of an inductor, a

resistor and a capacitor. This can be seen in Fig.2.3.
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𝑀𝑚 𝑅𝑚

𝑣𝑛
𝐶𝑚

Figure 2.3: Equivalent diagram of the mechanical part of the loudspeaker

Therefore, the mechanical impedance is given by -

Zm = jωMm +Rm +
1

jωCm
(2.5)

Acoustical parameters The acoustical part of the model consists of two forces acting on the

membrane. One on the front side of the membrane and one on the back. It is difference of these

forces that has to be included in the diagram as the stationary pressure is the same on both sides

of the membrane. The force acting on the membrane is defined as:

F = A(pback − pfront) (2.6)

where A is the area of the membrane. The acoustical equivalent diagram can be seen in Fig.2.4.

+

-
-

+

𝑝𝑓𝑟𝑜𝑛𝑡

𝑝𝑏𝑎𝑐𝑘

𝑞

Figure 2.4: Equivalent diagram of the acoustical part of the loudspeaker

where q is volume velocity, which is defined as:

q = vn.A (2.7)

This is used to relate pressure to acoustic radiation impedance:

pfront
q

=
−pback
q

= Zr (2.8)

where Zr is the acoustic radiation impedance.

The three individual equivalent diagrams can be combined to a complete equivalent diagram for

the loudspeaker. The connection between the parts of the diagram is determined by the magnetic
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force factor Bl and the membrane area A. The connection from the electrical to the mechanical

part is made by a gyrator, with a ratio of Bl : 1. The connection between the mechanical and the

acoustical part is made by a transformer with a ratio of A : 1. The complete equivalent diagram is

shown in Fig.2.5

𝐿𝑒 𝑅𝑒
𝐼 𝑀𝑚 𝑅𝑚 𝐶𝑚𝑣𝑛

+

-
-

+

𝑝𝑓𝑟𝑜𝑛𝑡

𝑝𝑏𝑎𝑐𝑘

𝑞

+

-

+

𝐵𝑙𝑣 𝐵𝑙𝐼

𝐵𝑙 ∶ 1 A ∶ 1

+

-

𝑈

Figure 2.5: Equivalent diagram of the acoustical part of the loudspeaker

Using these parameters, the loudspeaker can be modelled by obtaining the surface normal velocities

of the loudspeaker membrane. The methodology for calculating them was provided in the next

section.

2.2.2 Acoustic response: Infinite Baffle case

A 5” loudspeaker mounted in an infinite baffle was considered, the acoustical radiation impedance,

Zr, acou [15] is given as -

Zr,acou =
ρ0c

A
.(1−

2J1
2ωa
c

2ωa
c

+ j
2H1

2ωa
c

2ωa
c

) (2.9)

where J1 is first order Bessel function and H1 is first order Struve function. This radiation impedance

has to be included twice, since there is radiation from both the front and the back of the driver.

To simulate the acoustical response of a loudspeaker, it is most convenient to express electrical

and acoustical impedances in terms of equivalent of mechanical impedance.

When impedances are moved across the transformer between the mechanical and acoustical side,

the transformation factor is:

Zr,mech = Zr,acou.A
2 (2.10)

where Zr, acou is the radiation impedance of the driver and is dependent on how the driver is

mounted. After shifting the acoustical parts to mechanical side, the mechanical impedance can be
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found as:

Zmech = jωMm +Rm +
1

jωCm
+ Zr,mech (2.11)

To convert everything to mechanical impedances, now all the parts on the electrical side have to be

moved to the mechanical side. Since a gyrator is dividing the two sides, the process is [15]:

• Series connections of impedances change to parallel connections of admittances. This means

inductors change to capacitors and vice versa.

• When moving impedances from the electrical to the mechanical side, first divide by (Bl)2 and

then transform to admittance.

• When moving impedances from the mechanical to the electrical side, first transform to admit-

tance and then multiply by (Bl)2.

• Voltage and current are transformed as if it was a normal transformer.

By moving all the components to mechanical side, the equivalent diagram changes as show in

the Fig.2.6

𝐿𝑒
(𝐵𝑙)2

𝑀𝑚 𝑅𝑚 𝐶𝑚𝑣𝑛

+

-

(𝐵𝑙)2

𝑅𝑒

𝐹 = 𝐵𝑙𝐼 = 𝑈
𝐵𝑙

𝑅𝑒 + (𝑗𝜔)𝑛𝐿𝑒
2 𝑍𝑟,𝑎𝑐𝑜𝑢𝐴

2

Figure 2.6: Equivalent diagram of loudspeaker driver mounted in an infinite baffle, with all compo-
nent moved to mechanical side

The total mechanical impedance when the loud speaker is mounted in an infinite baffle is given by -

Zmech,tot = jωMm +Rm +
1

jωCm
+ 2Zr,acou.A

2 (2.12)

The membrane velocity vn in mechanical system is in analogy to the current in the electrical system.

When the membrane velocity is known, the volume velocity can be found as per the equation 2.6

q = vn.A(m3/s) (2.13)
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here q is the volume velocity, vn is the membrane velocity and A is the effective membrane area. To

calculate the pressure from the velocity vn, the distance and the area has to be used -

p = |ρ0Avn
2πx

jω|(Pa) (2.14)

where x is the distance to the source from the measurement position. The distance x is taken as

1m. The 2π is used because of the infinite baffle, which causes the loudspeaker to radiate into a

hemisphere. Other values could be 4π, describing radiation into free field or π/2 describing a speaker

positioned in a corner.

Figure 2.7: Variation of membrane velocity as a function of frequency
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Chapter 3

Modelling of Porous materials

3.1 Porosity and flow resistivity in porous materials

Porosity: The porous materials [16] consists of an elastic frame which is surrounded by air. The

porosity σ is the ratio of the air volume Va to the total volume of the porous material VT . Thus,

σ = Va/VT (3.1)

Let Vb be the volume occupied by the frame in VT . The quantities Va,Vb and Vt are then related by

Va + Vb = VT (3.2)

Only the volume of air which is not locked within in the frame is considered in Va and thus in the

calculation of the porosity. The latter is also know as the open porosity or connected porosity. For

most of the fibrous materials and plastic foams, the porosity lies very close to 1.

Flow resistivity One of the most important parameters that influence the absorption of a

porous material is its flow resistance. It is defined by the ratio of the pressure differential across a

sample of the material to the normal flow velocity through the material. The flow resistivity Ξ is

the specific (unit area) flow resistance per unit thickness.

h

𝑝1

𝑝2

𝑉

Figure 3.1: A portion of porous material inserted in a pipe. The pressure difference of p1−p2 causes
a steady flow V of air per unit of material
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The schematic of the set-up for the measurement of flow resistivity,σ is shown in the Fig.3.1.

The flow resistivity is given by -

σ = (p2 − p1)/V h (3.3)

In this equation, the quantities V and h are mean flow velocity of air per unit area of material and

the thickness of the material respectively.

3.2 Microscopic ans macroscopic description of sound prop-

agation in porous media

The parameters that are involved in sound propagation can be defined locally, on a microscopic

scale, for example in a porous material with cylindrical pores [?]having a circular cross-section, as

functions of the distance to the axis of the pores. On the microscopic scale because of the com-

plicated geometries, it is difficult to study the propagation of sound in porous materials. Only the

mean values of the parameters are of practical interest. The averaging must be performed on a

macroscopic scale, on a homogenization volume with dimensions sufficiently larger for the average

to be significant. But, it should be taken care that these dimensions should be smaller than the

acoustic wavelength. The description of sound propagation in porous materials can be complicated

as the sound excites and moves the frame of the material. If the frame is assumed to be motion-

less, the air inside the porous medium can be replaced on the macroscopic scale by an equivalent

free fluid. This equivalent free fluid has a complex effective density ρ and a complex bulk modulus

K. The wave number k and the Characteristic impedance Zc of the equivalent fluid are also complex.

3.3 The laws of Delany and Bazley and flow resistivity

The laws of Delany and Bazley [16] are used to replace a layer of porous material with an equivalent

layer of fluid material. Delany and Bazley have measured the complex wave number k and the

characteristic impedance Zc for a large range of frequencies in many fibrous materials with porosity

close to 1. Expressions for the wave number k and the characteristic impedance Zc given by Delany

and Bazley shows that the values of k and Zc are mainly dependent on angular frequency ω and on

the flow resistivity Ξ of the material.

Zc = ρ0c0[1 + 0.057X−0.754 − j0.087X−0.732] (3.4)

k =
ω

c0
[1 + 0.0978X−0.700 − j0.189X−0.595] (3.5)

where ρ0 and c0 are the density of air and the speed of sound in air and X is a dimensionless

parameter -

X = ρ0f/Ξ (3.6)

f being the frequency, where ω = 2πf .
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Delany and Bazley suggested the following boundary for the validity of their empirical expressions

in terms of X, as follows:

0.001 < X < 1.0 (3.7)

It may not be expected that these relations give a perfect prediction of acoustic behaviour of all the

porous materials in the frequency range mentioned by the above equation. These expressions for k

and Zc were modified and improved by Mechel [17]. They are -

Zc

ρ0c0
= 1 + 0.0485A−0.754 − j0.087A−0.73, A < 60

=
0.5A/π + j1.4

(−1.466 + j0.212A)
1
2

, A > 60
(3.8)

k

k0
= −j0.189A0.6185 + 1 + 0.0978A0.6929, A < 60

= (1.466− j0.212A)
1
2 , A > 60

(3.9)

where k0 = ω/c0 and A is the normalized flow resistance of a λ-deep layer; that is

A =
Ξλ

ρ0c0
(3.10)

Here λ is the wavelength of the air (at ambient temperature).
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Chapter 4

Methodology

As mentioned in the Introduction chapter, two cars were considered for methodology development

and they were named as MC1 and MC2. The developed methodology was validated on 18 cars which

were named as VC1, VC2,...., VC18 . It was intended to know the following -

1. sound propagation inside these cars

2. settings of the head unit

3. development of the target curve which should provide the preliminary information about the

car audio quality

The methodology was developed to know about these attributes based on -

1. Objective test

2. Subjective tests

The results from these objective test and subjective tests were together analysed to get the target

curve.

4.1 Objective Test:

To know about these attributes we need to measure sound pressure levels inside the car at all the

four seating positions by maintaining certain settings. To measure the sound pressure levels, we

need to play standard signals through the head unit in the car.

4.1.1 Uniformity Test:

To know how uniformly the sound is being propagated inside the car across all the seating positions,

a uniformity test was done.

Excitation signals:

Pink noise is used as a excitation signal in the test. Pink noise is a signal or process with a frequency
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spectrum such that the power spectral density (energy or power per Hz) is inversely proportional to

the frequency of the signal. In pink noise, each octave (halving / doubling in frequency) carries an

equal amount of acoustic power.

Default settings:

A special care was taken such that the head unit does not induce any gains to the standard input

signal. The chosen default settings were Bass = 0, Middle = 0, Treble = 0.

Procedure:

The measurement was done using a single microphone. The microphone was positioned to the level

of driver’s ear with the help of a tripod and holder. The volume level of the head unit is increased

uniformly and sound pressure level data was stored in the form of 1/3 octave band data and FFT.

This exercise was performed for all the seating positions in both the cars. The results were presented

in the next chapter 5.1.1

Figure 4.1: A test setup for measuring sound pressure levels using single microphone

Fig. 4.1 shows the equipment setup used for measuring the Sound Pressure Levels to check for

Uniformity inside the car.

4.1.2 Tuning conditions of the audio system :

Generally, any audio system introduce the distortion for a given input signal while reproducing. An

ideal audio system will reproduce exactly the input signal. However, it is quite challenging to get
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an ideal system. So, each audio system is tuned for a particular car model. One of the objective for

the current measurements is to find the tuning parameters of a given car. This data will help for

comparing different car audio systems.

Excitation signal:

A standard Pink noise signal carries an equal amount of sound power for each octave band. Hence,

when a Pink noise is played through an ideal audio system it should give a flat response (i.e., the

audio system should not modify the input signal).

Head unit settings:

Default settings were maintained (Bass = 0, Middle = 0, Treble = 0). 80 dB sound pressure level

was maintained at the driver’s position.

Procedure:

The sound pressure level measurements were done using Earthworks M30 microphone. The measure-

ments were taken only at the driver position maintaining 80dB. The sound pressure level information

is obtained in the form of octave band data. This exercise was performed on 18 cars so that this

data would be helpful in developing an algorithm to know how the audio system was tuned in a car.

The most popular genres in India according to the age is given in a SONY survey [18]. These

popular genres are -

1. Rock

2. Pop

3. Electronic

4. Metallica

5. Classic

6. R&B

7. Jazz

The tuning settings of these standard genres were provided in Appendix A.

Taking these settings as a reference, we tried to find the default audio system settings in various

cars using the proposed algorithms. These algorithms will provide the dominance of standard genres

in a default tuning system.

Algorithm - 1: (Single Genre Identification Method)

Step-1: Audible range of frequency is considered, 32 - 16000Hz
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Step-2: This frequency range is divided into octave bands

fn+1/fn = 2 (4.1)

fn = central frequency of (n)th band

fn+1 = central frequency of (n+ 1)th band

f1 = 32Hz

Total 10 octave bands were obtained - 32, 64, 125, 250, 500, 1000, 2000, 4000, 8000, 16000Hz.

Step-3: Sound pressure levels inside the car were measured in the octave band

(Lp)band = (Lp)32, (Lp)64, ....., (Lp)16000

(Lp)n = Sound pressure level of nth band

Step-4: The overall sound pressure level maintained at the driver’s seat is given by -

Leq = 10log10(Σ100.1Lpi) (4.2)

The mean sound pressure level is given by -

Lmean = 10log10(1/n(Σ100.1Lpi)) (4.3)

⇒ Lmean = Leq − 10

This Lmean is the ideal level of Lpi that is to be maintained for all the octave bands for a given

Pink noise. But the actual values of Lpi might be higher or lower than these ideal values. This

gives us the variation in tuning of audio system.

Step-5: How much each octave band is deviating from the mean value was calculated.

Deviation,∆ = Lpi − Lmean (4.4)

The ∆ values of all the octave bands indicate the default tuning condition of the given audio

system.

Step-6: Now, the default tuning setting of a given audio system was compared with the standard

genres (reference settings, SE) and it shows the deviations from the reference. The difference

was squared to apply Least Square approach.

(Error)band, Eband = ((SE)band −∆)2

Step-7: To have a good audio experience, gains should be given depending on whether it is a low

frequency band or mid frequency band or high frequency band. So, the 10 octave bands were

divided into 3 groups
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(a) Low frequency group comprises of 32, 64, 125Hz octave bands

(b) Mid frequency group comprises of 250, 500, 1000, 2000Hz octave bands

(c) High frequency group comprises of 4000, 8000, 16000Hz octave bands

Step-8: The total squared error sum for each frequency group is calculated. This was done for all the

reference settings

Sum of squared errors of low frequency group

ELow = E32 + E64 + E125 (4.5)

Sum of errors of mid frequency group

EMid = E250 + E500 + E1000 + E2000 (4.6)

Sum of errors of high frequency group

EHigh = E4000 + E8000 + E16000 (4.7)

Step-9: ELow,EMid and EHigh of each group was compared across all the reference settings and the

least value was identified. It was considered that the given car audio was dominantly tuned to

the reference setting corresponding to the least square error in a particular frequency group.

Step-10: A new tuning curve was formed by combing the selected reference setting values for each

frequency group.

This algorithm was applied for audio systems of 18 cars. The proposed algorithm has a limitation in

providing weighting to closely spaced genres. This algorithm is considering only a single genre which

has least error value. It is not considering the genres whose values are very close to the least error

value. These small variations in the error values might be because of some trivial reasons which may

be unavoidable at the time of taking measurements. This is the limitation of this algorithm.
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The limitation of algorithm 1 is reduced by proposing an alternative algorithm. The methodol-

ogy is discussed as follows -

Algorithm - 2: (Muitiple Genre Identification Method)

Step-1: Audible range of frequency is considered, 32 - 16000Hz

Step-2: This frequency range is divided into octave bands

fn+1/fn = 2

fn = central frequency of (n)th band

fn+1 = central frequency of (n+ 1)th band

f1 = 32Hz

Total 10 octave bands were obtained - 32, 64, 125, 250, 500, 1000, 2000, 4000, 8000, 16000 Hz.

Step-3: Sound pressure levels inside the car were measured in the octave band

(Lp)band = (Lp)32, (Lp)64, ....., (Lp)16000

(Lp)n = Sound pressure level of nth band

Step-4: The overall sound pressure level maintained at the driver’s seat is given by -

Leq = 10log10(Σ100.1Lpi)

The mean sound pressure level is given by -

Lmean = 10log10(1/n(Σ100.1Lpi))

⇒ Lmean = Leq − 10

This Lmean is the ideal level of Lpi that is to be maintained for all the octave bands for a given

Pink noise. But the actual values of Lpi might be higher or lower than these ideal values. This

gives us the variation in tuning of audio system.

Step-5: How much each octave band is deviating from the mean value was calculated.

Deviation,∆ = Lpi − Lmean

The ∆ values of all the octave bands indicate the default tuning condition of the given audio

system.

Step-6: Now, the default tuning setting of a given audio system was compared with the standard

genres (reference settings, SE) and it shows the deviations from the reference. The difference

was squared to apply Least Square approach.

(Error)band, Eband = ((SE)band −∆)2
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Step-7: To have a good audio experience, gains should be given depending on whether it is a low

frequency band or mid frequency band or high frequency band. So, the 10 octave bands were

divided into 3 groups

(a) Low frequency group comprises of 32, 64, 125Hz octave bands

(b) Mid frequency group comprises of 250, 500, 1000, 2000Hz octave bands

(c) High frequency group comprises of 4000, 8000, 16000Hz octave bands

Step-8: The total squared error sum for each frequency group is calculated. This was done for all the

reference settings

Sum of squared errors of low frequency group

ELow = E32 + E64 + E125

Sum of errors of mid frequency group

EMid = E250 + E500 + E1000 + E2000

Sum of errors of high frequency group

EHigh = E4000 + E8000 + E16000

Step-9: ELow,EMid and EHigh of each group was compared across all the reference settings and the

least value was identified. It was considered that the given car audio was dominantly tuned to

the reference setting corresponding to the least square error in a particular frequency group.

Up to this step, the procedure is same as in algorithm 1.

Step-10: Standard deviation (σ) of errors was identified across all the reference settings for all the three

frequency groups.

Step-11: A Target limit was calculated for each frequency group for each car.

TargetLimit, TLfreq.group = (min.)freq.group + 0.5 ∗ (σ)freq.group (4.8)

Step-12: Error normalization was done based on the target limit (TL) value for all frequency groups of

given cars.

Step-13: Reference settings with normalized values less than 1 are said to be with in the Target Limit

(TL). Multiple genres may exist for each frequency group.

Step-14: The normalized error values conveys us how far the default audio settings of a given car was

tuned from the standard genres.

This algorithm was applied for audio systems of 18 cars. The results of this algorithm were

discussed in the next section.
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4.2 Subjective tests:

As this problem is about the sound quality, the user perception is also to be taken into consideration.

For this purpose three types jury tests were conducted [19]. Three sound samples were selected which

have dominance of low, mid and high frequency ranges. These samples were modified according to

the requirement of the jury tests and recorded using Head Measurement System (HMS) [20].

Figure 4.2: A test setup for recording the sound samples using HMS

Fig.4.2 shows the HMS equipment setup used for recording the samples for the jury tests.

4.2.1 Jury test - 1:

Test objective: Selection of a good car audio.

Samples: 30 second signals [21] recorded at default settings in both the methodology cars, MC1

and MC2.

Environment: Participants are not allowed to adjust the loudness and they have to take the

test in a room instead of car.

4.2.2 Jury test - 2:

Test objective: To check the natural selection of car audio settings by the user, here the user is a

music expert.
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Samples: The selected sound samples for all three frequency ranges were played in the com-

petitor cars, MC1 and MC2.

Environment: The user (i.e., the music expert) was allowed to adjust the loudness and settings.

They have to take the test in the car itself.

4.2.3 Jury test - 3:

Test objective: Selection of a good equalizer setting for car audio.

Samples: 30 second signals recorded at default settings and the settings obtained from Jury

test - 2 in both the methodology cars, MC1 and MC2.

Environment: Participants are not allowed to adjust the loudness and they have to take the

test in a room instead of a car.

The jury tests were conducted on a customized software which was developed using VB.NET.

Seperate modules were developed separately for jury test 1 and jury test 3.

The details of the jury tests conducted are presented in the next section.

The results from objective test and subjective tests are analyzed together to come up with an

appropriate target curve.

After finding the Target curves, it was intended to know simulate the realistic sound field inside

the car compartment to know the role of the car interior materials on the sound field inside the car

compartment. For this purpose both FE and GA simulations were performed. The methodology

followed to achieve this was mentioned in the next section.

4.3 Receiver model

For FE simulations, the sound pressure levels were calculated at the node points which are of our

interest. In FE method, nodes are placed at the location of the ear of the listener. But in case of

GA method, a field point mesh is generated in front of the head positions of the listeners inside the

car compartment. The interested results from the GA method are calculated on these field point

meshes only. The receiver model for both the methods are shown in Fig.4.3
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Figure 4.3: Nodes at desired locations in the FE method and Field point mesh in GA method

4.4 Simulation methods, tools and settings

The combined simulation approach uses a frequency domain FE method to calculate the room trans-

fer function for low frequency and a time-domain GA-based algorithm for the high frequency room

transfer function. The simulation results from both methods are finally combined in the frequency

domain [??].

The source was modelled as an omnidirectional point source in the FE and GA domain. The

sound power levels as a function of frequency were given as input to the sources in FE and GA

domains.

With regard to the simulation set up in FE and GA domain, the following settings have been

used for all simulations throughout this study.

• Geometrical model was meshed with parabolic tetrahedron elements using an average element

size of approximately 80 mm. The simulations for 80mm mesh were run upto 1kHz. A

minimum of three elements per wave length is required to represent the wave character of the

sound field for parabolic elements, which yields the following meshing criteria:

lElement <
λmin

3fmax
=

c

3fmax
(4.9)

The frequency step width of 10 Hz was chosen. The expert settings regarding the direct FE

solver was chosen i.e., MUMPS solver with a tolerance of 10−6 in Virtual Lab.

• In the GA domain the user has to specify a lot more parameters. The frequency range from

1000 - 8000 Hz was simulated in steps of 10 Hz. The simulations are done for the store levels

of both ”No Transient” and ”Full STI” with time resolution of energy histograms = 5 ms;

maximum ray path order = 5; no. of rays = 10000; reflection order = 10.
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• In both FE and GA simulations, the car interior parts are provided with their respective

boundary properties i.e., surface impedance Zs. Except for the car interior materials the other

part of the car compartment was provided with the property of air.

The materials of the car interior parts are porous, highly inhomogeneous in nature and have

multiple layers. These porous layers were replaced by equivalent fluid materials using Delany and

Bazley [16] laws. These materials should be given surface impedance as the boundary property

in acoustic simulations. These simulations were performed in LMS Virtual Lab. In LMS Virtual

lab, instead of modelling the car interior parts as layered structure and giving surface impedances

to them individually, an equivalent surface impedance was calculated and was given as boundary

condition on the outer surface of the part. This equivalent surface impedance was calculated using

”Transfer matrix method”.

4.5 Transfer matrix method

Transfer matrix relates the total sound pressure and volume velocity at two points in a porous

element [16]. As mentioned in 1.5.1, the total sound pressure and volume velocity are assumed to be

continuous across the boundary layer of the material. This assumption is useful in writing a transfer

matrix for multiple layers and finding equivalent surface impedance.
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𝑝2, 𝑣2

𝑙1 𝑍𝑐1, 𝑘1 , Ξ1

Figure 4.4: A layer of porous material with characteristic impedance Zc1, wave number k1, flow
resistivity Ξ1 and thickness l1. p1, v1 and p2, v2 are the sound pressure and volume velocity on the
face of incidence and the back face of the material

Fig.4.4 shows a layer of porous material with characteristic impedance Zc1, wave number k1, flow

resistivity Ξ1 and thickness l1. The transfer matrix for this layer relating p1, v1 and p2, v2 can be

written as - [
T1

]
=

[
cos k1l1 jZc1sin k1l1
j

Zc1
sin k1l1 cos k1l1

]
(4.10)

[
p1

v1

]
=

[
T1

] [p2
v2

]
(4.11)

Similarly, transfer matrix can be written for a layered structure also. Consider a material with

n layers of different thickness and different materials.
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𝑝1, 𝑣1

𝑝2, 𝑣2

𝑙1
𝑍𝑐1, 𝑘1 , Ξ1

𝑝3, 𝑣3

𝑝𝑛+1, 𝑣𝑛+1

𝑙2

𝑙𝑛

𝑇1

𝑍𝑐𝑛, 𝑘𝑛 , Ξ𝑛 𝑇𝑛

𝑍𝑐2, 𝑘2, Ξ2 𝑇2

𝑝𝑛, 𝑣𝑛

Rigid termination

Figure 4.5: A structure with different layers of porous materials is shown. Each layer is provided
with characteristic impedance Zcn, wave number kn, flow resistivity Ξn and thickness ln

Fig.4.5 shows the labelled structure of a car interior material with respective properties for each

layer. The overall transfer matrix foe this structure can be written as -

[
T
]

=

[
cos k1l1 jZc1sin k1l1
j

Zc1
sin k1l1 cos k1l1

][
cos k2l2 jZc2sin k2l2
j

Zc2
sin k2l2 cos k2l2

]
..........

.....................

[
cos knln jZcnsin knln
j

Zcn
sin knln cos knln

]
(4.12)

[
T
]

=
[
T1

] [
T2

] [
T3

]
.......

[
Tn

]
(4.13)

[
p1

v1

]
=

[
T
] [pn+1

vn+1

]
(4.14)

Using the equations (3.3),(3.5) and (3.7), any layered structure can be replaced with an equivalent

fluid and the sound pressure and volume velocity at any two different points across the layer can be

related. The equivalent surface impedance for the layered structure is given by -

Zs =
p1
v1

(4.15)

From the above equations, it can be observed that the surface impedance is a complex number. The

real part indicates resistance and the imaginary part indicates the reactance of the material. The

reflection coefficient of the material is given by the expression -

R =
Zs

Z0
− 1

Zs

Z0
+ 1

(4.16)

where Z0 is the characteristic impedance.Z0 = ρ0c0, ρ = 1.225Kg/m3 which is he density of air and

c0 = 344m/s which is the speed of sound in the air. The reflection coefficient (R) is also a complex

number. The absorption coefficient (α) is given by the expression -

α = 1− |R|2 (4.17)
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From the equations (3.8),(3.9) and (3.10), it can be observed that the surface impedance (Zs), re-

flection coefficient (R) and absorption coefficient (α) are functions of the frequency f . From the

Fig.4.3, it can be observed that the seats, floor carpet and glass windows were present in different

colours in both FE and GA meshes. The materials with similar properties were grouped and were

provided with equivalent properties. The configurations of the car interior parts considered and

their corresponding material properties were given in Appendix F and G

The expected outputs from the Finite element simulations are the Acoustic modes and Acoustic

forced response. These gives us an idea of the collection of resonances that exist in a car interior

volume when it is excited by an acoustic source such as a loudspeaker. These resonances effect

the low-frequency response of a sound system in the car interior volume and are one of the biggest

obstacles to accurate sound production.

The expected outputs from the Geometrical Acoustic simulations are Initial Time Delay Gap

(ITDG), Binaural Quality Index (BQI) and Inter Aural Cross-Correlation (IACC).

ITDG : The Initial Time Delay Gap describes the time difference between arrival of the direct

wave and first strong reflection at the listener. This is shown in the Fig.4.6. Nearby sources causes

a long ITDG. The ITDG is one of the most important cues for estimating the distance regarding

the sound source. The ITDG isn’t a constant for a room; it is dependent on source and listener

position. Best values for ITDG in concert halls are somewhere between 12 and 25 milliseconds. For

car interior, the ITDG value should be less than 80 milliseconds to have a good listening experience.

53

Time in milliseconds 

𝑅1
𝑅2

𝑅3

𝑅4

𝑅5

𝑅6

Reflections
Direct 

sound

L
o
u
d

n
es

s Initial – time delay gap

ITDG 

Figure 4.6: Schematic of the sound signals comprising of direct sound and reflected sounds on the
time scale

IACC : To explain IACC, when a lateral reflection reaches a listener, it impinges on the closest

ear without change. After it travels around the head, it will be decreased in amplitude and will be

delayed in time. The IACC takes into account all of the lateral reflections impinging on both sides

of the head within a stated time, including the differences in their amplitudes and time differences

at the two ears. The value of IACC range between -1 and +1. If IACC = -1, it means that both
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the ears are getting same signal but they are opposite in phase. If IACC = +1, it means both the

ears are getting the signals which are equal in amplitude and phase. IACC = 0 means the signals

received by both the ears are completely different.

γ(τ) =

∫ t2
t1
pL(t)pR(t+ τ) dt√∫ t2

t1
pL2(t)pR2(t+ τ) dt

(4.18)

IACC = mac(|γ(τ)|) (4.19)

BQI : The Binaural quality index equals the quantity [1− IACCE3] [22], where ’E’ refers to the

early time and ’3’ refers to the average of the three octave bands 500, 1 K and 2 K Hz. BQI speaks

about the quality of the signal reached to the receiver when the receiver’s position is not stable with

respect to the source.

35



Chapter 5

Results and Discussion

The current chapter discuss the results of the objective test and subjective tests obtained for two

car models. A detailed inference will also be presented for all the results.

5.1 Objective test:

Objective test was performed to check the uniformity of sound pressure levels inside the car and to

identify the settings to which the car audio was tuned for default conditions.

5.1.1 Uniformity:

The graphs representing the uniformity of sound pressure levels inside the car are represented in

Fig.5.1

Figure 5.1: Uniformity curves of MC1 and MC2
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In the uniformity graphs, the x - axis represents the volume level setting of the head unit of the

car and y - axis represents the sound pressure level inside the car.

In the Fig.5.1, taking the position - 1 i.e., driver seat as the reference, from the two graphs it can

be observed that the front two seating positions are having almost same amount of sound pressure

levels and the rear two seating positions are having almost same amount of sound pressure levels .

But there is difference between the sound pressure levels of front and rear positions of the car. This

difference increases with the volume level of the audio system in the car and the difference was in

the order of 3 dB.

Similarly, the uniformity condition in other two cars that are considered for uniformity test, UC1

and UC2 is shown in the Fig.5.2

Figure 5.2: Uniformity curves of UC1 and UC2

From the Fig.5.2, it can be observed that in these two cars UC1 and UC2, the sound pressure

levels between the front and rear part of the car are having more difference when compared to that

of the two competitive cars MC1 and MC2. Particularly in UC2, the difference in sound pressure

levels between the front and rear part of the car is as high as 5dB which is not desirable.

5.1.2 Genre identification:

This section discuss the results obtained from Algorithm - 1 and Algorithm - 2 for all 18 cars.

The methodologies of Algorithm - 1 and 2 were discussed in the previous chapter.
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Algorithm - 1: ( Single genre Identification Method)

This Algorithm is intended to identify which reference setting is predominant in the default tun-

ing settings of the car in three frequency groups.

Algorithm - 1 has been validated on 18 different cars. For example let us discuss the validation

car VC1 results -

Table 5.1: Algorithm - 1 results for VC1
Ref. setting ΣElow ΣEmid ΣEhigh

Rock 115.3 34.4 1108.1
Pop 59.2 72.5 670.7

Classical 112.8 41.8 1133.4
Metal 316.9 112.2 1784.9

Electronic 114 6.5 1141
R&B 79.9 40.8 1113.9
Jazz 104.4 34.8 1026

From Table 5.1, it can be observed that for VC1 in low frequency group ”Pop” is having the

minimum ΣElow value. In mid frequency group ”Electronic” is having the minimum ΣEmid value.

In high frequency group again ”Pop” is having the minimum ΣEhigh value. From this the Algorithm

- 1 says that the audio system of Renault Duster is tuned to Pop for low frequency range, Electronic

for mid frequency range and Pop for high frequency range in default settings.

Similarly, let us discuss another validation car VC15 results -

Table 5.2: Algorithm - 1 for VC15
Ref. setting low mid high

Rock 93.1 59.8 367.5
Pop 109.0 187.0 141.8

Classical 101.1 74.4 380.0
Metal 132.5 219.3 778.1

Electronic 76.6 60.6 382.0
R&B 109.5 80.3 373.1
Jazz 78.2 62.0 318.2

Table 5.2 shows results of VC15. It can be observed that in low frequency group ”Electronic” is

having the minimum ΣElow value. But, it can also be observed that the difference between Elec-

tronic and Jazz values is very small. This difference might be because of many trivial aspects. This

is the same case between Rock, Electronic and Jazz in the mid frequency range. In high frequency

group again ”Pop” is having the minimum ΣEhigh value.

From this we can say that Algorithm - 1 gives us only the standard genres that is very close to

the tuning condition of the audio system of a given car. It is not considering the other standard

genres which also have a influence in the tuning setting of the audio system. This has motivated us
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to develop Algorithm - 2.

Results of all the 18 cars by this algorithm were provided in Appendix B.

Algorithm - 2: ( Multiple Genre Identification Method )

Algorithm - 2 gives multiple standard genres contribution in the tuning of the audio system of a

given car for a particular frequency range.

Following the methodology of Algorithm - 2, we can say that for a given car in a particular

frequency range the reference settings whose normalized ΣEfreq.range values are less than or equal

to 1 have their influence in the default tuning settings.

Let us discuss into the previous example of VC15 -

Table 5.3: Algorithm - 2 results for VC15
Ref. setting low mid high

Rock 93.1 59.8 367.5
Pop 109.0 187.0 141.8

Classical 101.1 74.4 380.0
Metal 132.5 219.3 778.1

Electronic 76.6 60.6 382.0
R&B 109.5 80.3 373.1
Jazz 78.2 62.0 318.2

From Table 5.3, it can be observed that for low frequency range

Minimum ELow value = 76.6

Standard deviation (σ) = 19.5

From Eq.2.6, Target Limit for low frequency range (TLLow) = 86.4

A similar exercise is followed for mid frequency and high frequency bands and their respective

target limit values were calculated. Using these target limit values normalization of squared error

values was done for each frequency range.

Table 5.4: Normalized values for VC15
Ref. setting Low Mid High

Rock 1.0 0.6 1.5
Pop 1.2 2.0 0.6

Classical 1.1 0.8 1.6
Metal 1.5 2.3 3.3

Electronic 0.9 0.6 1.6
R&B 1.2 0.8 1.5
Jazz 0.9 0.6 1.3

From Table 5.4 it can be observed that the normalized ΣElow values of Electronic and Jazz are

less than 1. For mid frequency range, the normalized ΣEmid values of Rock, Classical, Electronic ,
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R&B and Jazz are less than 1. For high frequency range, the normalized ΣEhigh values of Pop is

less than 1.

The normalized sum of errors in each frequency range conveys the dominance of standard genres

in a default tuned conditions or each frequency range. If the normalized value is ”0”, it means the

audio system was tuned exactly to that reference setting. The normalized value of the target limit

is ”1”.

Results of all the 18 cars by this algorithm were provided in Appendix C.

A further research is required to find an appropriate scaling factor for finding the Target Limit

(TL) and also the contribution of single genre vs multiple genre on preferred sound quality.

These two algorithms helps us in comparing different car audio quality without subjective tests.

5.2 Subjective tests:

The purpose of the subjective test is to capture the user perception on the product quality. Based

on the project objective, three types of jury tests were conducted. The results have been discussed

in the following section.

5.2.1 Jury test - 1: ( Pair comparison test )

For Jury test 1, as it was intended to find out which car has the better audio quality, the software

was developed in a way to compare the same sound sample that was recorded at default settings in

the two competitive cars MC1 and MC2. Hence, samples were presented in pairs to the subject. In

this pair comparison test, the subject can listen to the samples as many times as he can and has to

rate the samples on a verbal scale of 1 - 5. One pair of samples will be presented at a time to the

subjects and they have to compare and rate six such pairs of samples. To maintain the consistency

in the responses, the first three sample pairs were presented in a reverse order as the last three

sample pairs. The responses given by the subject were recorded time to time and the software was

designed in a manner such that the subject can’t exit the test in the middle.

Verbal Scale:

1 - sample 1 is strongly preferred

2 - sample 1 is preferred

3 - sample 1 and sample 2 are equally preferred

4 - sample 2 is preferred
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5 - sample 2 is strongly preferred

Settings: ( Default settings)

Bass = 0, Middle = 0 and Treble = 0.

Sample nomenclature:

Table 5.5: Sample nomenclature for Jury test - 1
Sample type MC1 MC2

Low Frequency S1 W1
Medium Frequency S2 W2

High Frequency S3 W3

Table 5.5 gives the names of the samples that were used in Jury Test 1.

Results:

Total 21 participants took jury test 1. The responses of all the participants were collected and

averaged. If the average response value is less than 3 then it can be interpreted as sample 1 is

preferred than sample 2 and if the average response value is more than 3 then it can be interpreted

as sample 2 is preferred than sample 1.

Table 5.6: Results of Jury test - 1
Jury Test 1

Avg Rating Prefered Car
MC1 (S1) Vs MC2 (W1) 3.2 MC2
MC1 (S2) Vs MC2 (W2) 3.3 MC2
MC1 (S3) Vs MC2 (W3) 3.3 MC2
MC2 (W1) Vs MC1 (S1) 2.2 MC2
MC2 (W2) Vs MC1 (S2) 2.6 MC2
MC2 (W3) Vs MC1 (S3) 2.6 MC2

From the results provided in Table 5.6, it can be observed that MC2 car audio system at default

settings was preferred to that of MC1 car audio.

The snapshot of the GUI for Jury test - 1 was presented in Appendix D.

5.2.2 Jury test - 2:

In this the user was allowed to adjust the loudness and settings of the car audio as per his require-

ment to attain a proper sound quality.

A music expert was made to participate and allowed him to adjust the audio settings in both

the cars.
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Results:

The settings adjusted by the music expert were the outcome of this test.

Table 5.7: Expert settings
MC1 MC2

Bass - +5 Bass - +5
Mid - +7 Mid - -3

Loudness - ON Treble - +7

Table 5.7 provides the expert settings in both the competitor cars.

5.2.3 Jury test - 3: ( Preference rating )

In this test, the samples recorded in MC1 & MC2 at both default and expert settings were rated

on a verbal scale of 1 - 10 by jury members. This test is done only for Low frequency and Mid

frequency samples because from the Algorithm - 1 and 2 results shows that all the cars were tuned

to ”Pop” genre for high frequencies.

Jury test 3, was intended to find out which equalizer setting was preferred by the jury. Two

different settings were considered for the jury test. So, the subject has to compare four samples

at once which makes the Pair Comparison Test not possible in this case. So, we opted for the

”Preference Rating Test”. In this test the subject has to listen to all the four samples and should

give a rating to it between 1 - 10. The following settings were designed in the software for listening

test -

1. the subject can’t rate the sample without listening to it

2. the subject can’t rate the samples without listening to all the samples atleast once

3. the subject can’t exit the test in the middle.

The snapshot of the GUI for Jury test - 3 was presented in Appendix E.

Sample nomenclature:

Table 5.8: Sample nomenclature for Jury test - 3:
Low frequency samples Mid frequency samples

Setting MC1 MC2 MC1 MC2
Default pd1 fd1 pd2 fd2
Expert pe1 fe1 pe2 fe2

In the nomenclature of the samples provided in Table 5.8, ”pd” stands for default settings in

MC2 and ”pe” stands for expert settings in MC1. The nomenclature ”fd” and ”fe” stands same for

MC2 as in the case of MC1.
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Results:

Total 51 participants took jury test 3. The responses of all the participants were collected and

averaged. The purpose of this analysis is to know how the responses were given among the four

samples in each test. For this purpose the standard deviation of the responses was calculated as -

σ =
√

(x− xi)2/n (5.1)

x = mean of the responses

xi = individual response value

n = total no. of responses

Now, the range of responses was found.

Range = max.response−min.response (5.2)

No. of Standard deviations (σ) that can be accommodated in the range

= Range/σ (5.3)

Table 5.9: Results for Jury test - 3

Low frequency samples Mid frequency samples
fd1 fe1 pd1 pe1 fd2 fe2 pd2 pe2

Average 7.1 5.8 6.2 6.9 6.9 6.7 6.7 7.5
Min 3.0 2.0 3.0 3.0 2.0 3.0 3.0 3.0
Max 10.0 10.0 9.0 9.0 10.0 10.0 10.0 10.0
Stdev 1.6 1.8 1.3 1.4 1.7 1.5 1.5 1.7

no of stdev 4.5 4.6 4.5 4.3 4.7 4.7 4.6 4.2

Figure 5.3: Distribution of responses among the samples for Low frequency samples in Jury test - 3
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Figure 5.4: Distribution of responses among the samples for Mid frequency samples in Jury test - 3

From Table 5.9 , it can be observed that the no. of standard deviation values is between 4 and 5.

So, the value was approximated to the nearest integer 5. For the given example, the size of response

range is 10/5 = 2.

From the Table 5.9, it can be observed that for low frequency range, jury response was towards

the default settings in MC2 and for mid frequency range, jury response was towards the expert

settings in MC1.

Fig.5.3 and Fig.5.4 shows the distribution of response values among the subjects.

5.3 Target Curves:

The target curves were developed based on subjective and objective test results. The gains of these

target curves were obtained from the Algorithms.

Pink noise was played through the audio systems of MC1 & MC2 by applying default settings

and expert settings. SPL data in each octave band was obtained, then Algorithm - 1 gives the ∆

values. These ∆ values are considered as the gains of the respective octave bands for that particular

settings in both the cars.

From the subjective tests it was known that Jury preferred ”MC2 default settings” for low

frequencies and ”MC1 expert settings” for mid frequencies. So for Target curve - 1, we considered

MC2 default settings for all the frequency ranges and for Target curve - 2, we considered MC2

default settings for low and high frequency ranges and MC1 expert settings for mid frequency range.

These proposed curves need to be validated in actual testing conditions.
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Table 5.10: Target Curves
MC2 MC2 Exp MC1 MC1 Exp Target Curve 1 Target Curve 2

32 -3.5 -2.9 -2.7 0.8 -3.5 -3.5
64 -0.9 3.0 4.8 6.1 -1.0 -1.0
125 4.7 4.8 6.3 5.3 5.0 5.0
250 3.1 3.7 0.4 -2.3 3.0 -2.0
500 0.9 -2.2 -4.4 -8.7 1.0 -9.0
1000 0.6 -3.5 -7.3 -8.3 0.5 -8.0
2000 -2.5 -3.7 -5.4 -9.4 -2.5 -9.0
4000 -2.8 -5.2 -8.2 -7.6 -2.8 -2.8
8000 -8.0 -6.1 -12.6 -9.7 -8.0 -8.0
16000 -11.9 -9.5 -20.2 -15.7 -12.0 -12.0

Figure 5.5: Target curves based on MC1 and MC2 data

Table 5.10 and Fig.5.5 shows the gain values that were obtained by applying the algorithms.
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5.4 Boundary properties of the car interior parts using Trans-

fer Matrix Method

This section provides the absorption coefficients and surface impedance values of the car materials

which are obtained using Transfer matrix method.

Seat cushions
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Figure 5.6: Variation of real and imaginary parts of the surface impedance of seat cushions with
frequency
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Figure 5.7: Variation of absorption coeff. of seat cushions with frequency
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Glass windows
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Figure 5.8: Variation of real and imaginary parts of the surface impedance of windows with frequency
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Figure 5.9: Variation of absorption coeff. of windows with frequency
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Carpets
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Figure 5.10: Variation of real and imaginary parts of the surface impedance of Carpet with frequency
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Figure 5.11: Variation of absorption coeff. of carpet with frequency

Among the three car interior materials considered, only seat cushions and carpet have compar-

itively good absorption characteristics. This can be observed from Fig.5.7, 5.9 and 5.11. For both

seat cushions and carpet, the absorption coeff. is increasing with the frequency. But as the glass

window is not a sound absorbing material, it is noticed that the absorption coeff. value of glass

window rapidly falls to a value close to zero. Glass windows show higher absorption values at very

low frequencies.

From the fig.5.6, 5.8 and 5.10, it can be observed that the surface impedance is a strong function

of frequency. It can be observed that the materials which have better absorbing characteristics show

a considerable variation of the resistance (i.e., the real part of the surface impedance). But the glass

windows which doesn’t have good sound absorption has it’s surface impedance value almost equal
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to that of the Characteristic impedance. The reactance values(i.e., the imaginary part of the surface

impedance) of seat cushions and carpets which have good sound absorption were almost close to

zero from the low frequency range itself. But in case of glass windows the reactance values were

varying linearly with the frequency.

5.5 Results from FE and GA domain simulations

The results from the acoustic simulations were intended to give us an idea about the audio quality

condition of the car interior. The expected results from the Finite element (FE) simulations are

acoustic modes, acoustic forced response and the Inter-aural level difference (ILD). The expected

results from Geometric acoustics (GA) simulations are Initial Time Delay Gap (ITDG), Inter-Aural

Cross Correlation (IACC) and Binaural Quality Index (BQI).

5.5.1 Finite element simulations:

The acoustic modes are calculated. Room modes are the collection of resonances that exist in a

room when the room is excited by an acoustic source such as a loudspeaker. These resonances

affect the low-mid-frequency response of a sound system in the room and are one of the biggest ob-

stacles to accurate sound reproduction. The first ten modes of the car cabin are given in the Fig.5.12
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Mode no. Hz

1 2.81𝑒−4

2 51.1

3 92.0

4 117.0

5 123.0

6 147.2

7 150.5

8 162.0

9 175.4

10 176.2
Fundamental mode @ 51.1Hz Second acoustic mode @ 92.0Hz

Figure 5.12: First ten acoustic modes and mode shapes for fundamental and second acoustic modes

From the acoustic forced response, the sound pressure levels at the nodes of interest can be obtained.

The nodes are located at the positions of left and right ears of the all four listeners inside the car.

The ILD for the four seating positions was given in the Fig.5.13
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Figure 5.13: Inter-Aural Level Difference at all the four seating positions in car compartment

It can be observed from the Fig.5.13 that after around 250 Hz, at all the positions the ILD is more

than 3 dB which is not desirable for a good audio experience. Hence, all the four seating positions

don’t have the property of a ”Hotspot”.

5.5.2 Geometrical Acoustics simulations:

The results from GA simulations are - Initial Time Delay Gap(ITDG)

Figure 5.14: Initial Time Delay Gap at all the four seating positions in car compartment

From the Fig.5.14 it can be observed that the ITDG values went as high as 2.32 seconds which is not

even in close proximity to the optimum value of 80 milliseconds. This might be due to the presence

of more amount of acoustic material which causes absorption of the sound and delays the reflections.

Inter Aural cross Correlation(IACC)

It can be observed from the Fig.54, that the maximum value of IACC on the field mesh is 0.395

which says that the signals reaches to the two ears of the listener are not exactly identical. This
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might be because of the inappropriate orientation of the speakers in the door cavity.

Figure 5.15: Inter Aural cross Correlation at all the four seating positions in car compartment

Binaural Quality Index(BQI)

Figure 5.16: Binaural Quality Index at all the four seating positions in car compartment

The optimum value of BQI to have a good audio experience is around 0.65 [22]. In the Fig.5.16, it

can be observed from the contour plots that the region around the passenger’s head with optimum

values of BQI is very small.
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Chapter 6

Summary and Future work :

6.1 Summary:

An extensive literature study has been done to find out the factors affecting the car audio quality.

Car audio measurement methodology has been established. Interior Sound Pressure Level distri-

bution were compared in the competitor cars (Uniformity check). Indian customer’s preferences

in music/audio were obtained from SONY survey. It provides information on the preferred genre

according to age group.

A new algorithm is proposed to find how the audio system is tuned in a given car with respect to

the standard genre and measured data. It was found that almost all the cars are tuned in the same

manner for High frequencies. Three sound samples were selected for jury test that represents Low,

Mid and High frequency ranges. Subjective test procedure has been proposed in which three types

of jury tests have been conducted to establish a target curve. In Jury Test – 1, samples recorded

in MC1 and MC2 at default audio settings are used. MC2 audio is preferred in Jury Test – 1 for

all the frequency ranges. Jury test 2 provides expert settings for preferred audio. In Jury Test – 3,

samples recorded at default and expert settings in both the cars for low and mid frequency ranges

is used. MC2 default settings are preferred for Low frequency range and MC1 expert settings are

preferred for Mid frequency range. Based on the objective and subjective data analysis, two target

curves have been proposed.

Simulation methodology of acoustic sound field inside the car was developed for low to mid

frequency region using FE method and from mid to high frequency region using GA methods. Ap-

propriate models for geometry, source, receiver and boundary conditions were provided for both FE

and GA domains. Identification of “Hotspots” is an important outcome from the FE simulations.

These Hotspots gives an idea about the quality of sound received by the passenger at low frequencies.

It was observed that none of the seating positions inside the car has the property of a ”Hotspot”.

Using the GA simulations, psycho-acoustic parameters like ITDG, IACC and BQI which describes

about the quality of sound in high frequency region inside the car are verified. ITDG has a value

much higher than it’s desirable value, which might be due to the presence of acoustic material near

the seating positions. The IACC and BQI values from GA simulations indicate that there is no
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proper correlation between the signals reached to the two ears of the listener. This might be because

of the inappropriate orientation of the speakers in the door cavity.

6.2 Future work:

Although the methodologies developed here are very useful to understand the sound quality of au-

dio system inside the car yet the following research topics or endeavours are worthy of further studies:

1. Validation of Target curves.

2. Characterization of Loud Speakers and Car interior.

3. Correlate the data measured in HMIE and IITH.

4. There is a good amount of research scope for fine tuning the Target curve by eliminating the

current assumptions.

5. The established methodology of the simulations should be validated with the objective tests

i.e., sound pressure measurements in the car compartment.

6. The subjective tests have to be conducted and the results are to be correlated with the psycho-

acoustic parameters obtained from the simulations.

7. A parametric study can be done by taking different configurations of loudspeakers and by

changing their location. This gives design guidelines to acoustically model the car compartment

to get a good audio experience.
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Appendix

Appendix A:

Table 1: Tuning settings of Standard equalizers

Octave band(Hz) Rock Pop Classical Metal Electronic R&B Jazz
32 4.5 -1.5 4.5 10.5 4 2 3.5
64 4 -1 4 7.5 3 7 2.5
125 2.5 0 3 0 1 5 1
250 1 1.5 2.5 5 -0.5 1.5 1.5
500 -1 4 -1.5 0 -2.5 -2 -1.5
1000 -1.5 4 -1.5 0 1.5 -1.5 -1.5
2000 0 1.5 0 6 0.5 2 0
4000 2 0 1.5 0 1 2.5 1
8000 3 -1.5 3 9 3.5 3 2.5
16000 4 -2 4.5 11.5 4.5 4 3
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Appendix B:

Table 2: Algorithm - 1 results for all test cars
32 64 125 250 500 1000 2000 4000 8000 16000 Low freq. Mid freq. High freq.

VC1 -1.5 -1 0 -0.5 -2.5 1.5 0.5 0 -1.5 -2 pop electronic pop
VC2 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 pop rock pop
VC3 -1.5 -1 0 -0.5 -2.5 1.5 0.5 0 -1.5 -2 pop electronic pop
VC4 2 7 5 -0.5 -2.5 1.5 0.5 0 -1.5 -2 R&B electronic pop
VC5 -1.5 -1 0 2.5 -1.5 -1.5 0 0 -1.5 -2 pop classical pop
VC6 -1.5 -1 0 2.5 -1.5 -1.5 0 0 -1.5 -2 pop classical pop
VC7 2 7 5 -0.5 -2.5 1.5 0.5 0 -1.5 -2 R&B electronic pop
VC8 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 pop rock pop
VC9 -1.5 -1 0 1 -1 -1.5 0 1 2.5 3 pop rock jazz
VC10 2 7 5 1.5 -1.5 -1.5 0 1 2.5 3 R&B jazz pop
VC11 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 pop rock pop
VC12 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 pop rock pop
VC13 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 pop rock pop
VC14 3.5 2.5 1 1 -1 -1.5 0 0 -1.5 -2 jazz rock pop
VC15 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 electronic rock pop
VC16 2 7 5 1.5 -1.5 -1.5 0 0 -1.5 -2 R&B jazz pop
VC17 3.5 2.5 1 1 -1 -1.5 0 0 -1.5 -2 Jazz rock pop
VC18 -1.5 -1 0 1 -1 -1.5 0 0 -1.5 -2 pop rock pop
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Appendix C:

Table 3: Algorithm - 2 results for all test cars
Rock Pop Classical Metal Electronic R&B Jazz Total

VC1(L) 1.1 0.6 1.1 3.1 1.1 0.8 1.0 2.0
VC1 (M) 1.5 3.1 1.8 4.8 0.3 1.7 1.5 1.0
VC1 (H) 1.3 0.8 1.4 2.1 1.4 1.3 1.2 1.0

VC2(L) 1.3 0.6 1.3 3.1 1.1 1.0 1.1 2.0
VC2(M) 0.5 2.6 0.8 2.7 0.9 0.5 0.6 5.0
VC2(H) 1.6 0.5 1.7 3.7 1.7 1.7 1.4 1.0

VC3(L) 1.2 0.9 1.2 1.4 1.1 1.3 1.1 1.0
VC3(M) 1.0 1.1 1.0 1.2 1.0 1.0 1.0 1.0
VC3(H) 1.1 1.0 1.1 1.2 1.1 1.1 1.1 1.0

VC4(L) 0.9 0.9 0.9 2.4 0.8 0.7 0.8 6.0
VC4(M) 0.5 2.2 0.9 2.8 0.5 0.8 0.7 5.0
VC4(H) 1.6 0.4 1.7 4.1 1.8 1.7 1.4 1.0

VC5(L) 1.4 0.4 1.3 4.2 1.2 1.4 1.1 1.0
VC5(M) 0.7 1.4 0.6 2.8 1.3 1.3 0.7 3.0
VC5(H) 1.6 0.6 1.6 3.4 1.6 1.6 1.4 1.0

VC6(L) 1.3 0.6 1.4 3.2 1.2 1.0 1.1 1.0
VC6(M) 0.8 1.0 0.7 2.2 0.9 1.2 0.8 5.0
VC6(H) 1.5 0.7 1.5 2.8 1.5 1.5 1.3 1.0
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Rock Pop Classical Metal Electronic R&B Jazz Total
VC7(L) 0.9 0.6 0.9 3.2 0.9 0.5 0.8 6.0
VC7(M) 0.5 2.5 0.5 3.3 0.4 0.9 0.4 5.0
VC7(H) 1.6 0.6 1.6 3.4 1.7 1.6 1.4 1.0

VC8(L) 1.5 0.6 1.5 3.0 1.4 1.3 1.3 1.0
VC8(M) 0.6 1.4 0.7 3.0 1.2 1.2 0.7 3.0
VC8(H) 1.5 0.5 1.6 3.9 1.6 1.5 1.3 1.0

VC9(L) 1.5 0.7 1.5 2.6 1.4 1.2 1.3 1.0
VC9(M) 0.6 2.4 0.7 2.8 1.3 1.0 0.6 4.0
VC9(H) 0.6 0.6 0.7 3.9 0.6 0.6 0.4 6.0

VC10(L) 1.1 0.9 1.1 2.9 1.2 0.6 1.1 2.0
VC10(M) 0.5 2.8 0.5 3.1 1.1 0.9 0.4 4.0
VC10(H) 1.3 0.8 1.3 1.9 1.3 1.3 1.3 1.0

VC11(L) 1.3 0.5 1.3 3.5 1.1 1.0 1.0 1.0
VC11(M) 0.6 2.3 0.7 2.6 1.9 1.1 0.6 3.0
VC11(H) 1.7 0.3 1.7 4.6 1.8 1.7 1.4 1.0

VC12(L) 1.3 0.6 1.3 3.0 1.2 1.0 1.1 2.0
VC12(M) 0.2 3.3 0.4 4.2 1.6 1.0 0.3 4.0
VC12(H) 1.7 0.3 1.7 4.7 1.8 1.7 1.4 1.0

VC13(L) 1.4 0.5 1.5 3.6 1.3 1.2 1.1 1.0
VC13(M) 0.5 2.5 0.6 2.6 2.0 1.0 0.6 3.0
VC13(H) 1.6 0.3 1.7 4.7 1.8 1.6 1.3 1.0

VC14(L) 0.9 1.1 1.0 2.0 0.8 0.8 0.8 5.0
VC14(M) 0.6 2.0 0.7 2.5 1.1 1.0 0.6 3.0
VC14(H) 1.6 0.6 1.7 3.5 1.7 1.7 1.4 1.0
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Rock Pop Classical Metal Electronic R&B Jazz Total
VC15(L) 1.1 1.3 1.2 1.5 0.9 1.3 0.9 2.0
VC15(M) 0.6 2.0 0.8 2.3 0.6 0.9 0.7 5.0
VC15(H) 1.5 0.6 1.6 3.3 1.6 1.6 1.3 1.0

VC16(L) 1.1 1.3 1.1 3.7 1.3 0.5 1.2 1.0
VC16(M) 0.7 2.3 0.7 2.0 1.1 0.9 0.7 4.0
VC16(H) 1.4 0.8 1.4 2.3 1.4 1.4 1.3 1.0

VC17(L) 1.1 0.9 1.2 1.8 0.8 1.4 0.8 3.0
VC17(M) 0.8 1.4 1.2 2.1 1.0 1.0 0.9 3.0
VC17(H) 1.6 0.5 1.7 3.7 1.7 1.6 1.4 1.0

VC18(L) 1.2 0.7 1.2 2.7 1.1 0.8 1.1 2.0
VC18(M) 1.0 2.2 1.3 3.5 0.5 1.3 1.1 1.0
VC18(H) 1.7 0.3 1.7 5.1 1.8 1.7 1.3 1.0
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Appendix D:

Figure 1: Snapshot of GUI for Jury test - 1 (Pair Comparison Test)
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Appendix E:

Figure 2: Snapshot of GUI for Jury test - 3 (Preference Rating Test)
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Appendix F:

The layered absorber configurations of the car interior materials are:

seat cushion: A → B → C → D → Y

floor carpet: E → Y

windows: F → Z

Appendix G:

Description of the layers according to their properties:

Table 4: Thickness and Flow resistivity of the absorber materials that were considered for the seat
cushions and car carpet

Letter indicator Material Thickness, mm Flow resistivity, KPas/m2

A Fabric cover for seats 1.3 800

B White porous material 8.5 11.9

C Grey porous foam 19.2 21.8

D Beige porous foam 54 42.5

E Black carpet (floor carpet) 4.0 30

Properties of glass plate are given as -

. Thickness = 5 mm

. Density = 2500 Kg/m3

. Young’s modulus = 70,000 N/mm2

. Poissons ration = 0.3

The termination conditions for the car interior materials are -

Y : Rigid termination (Zterm →∞)

Z : Free field termination (Zterm = Z0)
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Appendix H:

Low frequency analysis of the acoustic simulation of sound field inside the

car passenger compartment

This chapter explains the step-by-step procedure for the simulation of sound field inside the car

compartment.

1. Open LMS Virtual.Lab. Start the Acoustic Harmonic FEM module. This will create a new

analysis window with a pre-defined tree.

Start → Acoustics → Acoustic Harmonic FEM

2. Import the volume mesh of the desired car model with a compatible mesh file format as shown

in Fig.3.

Links Manager → Right Mouse Button → Import

Figure 3: Importing the mesh (1)

3. After selecting the desired file, a window will open as shown in Fig.4. Select the working units

for Length and Mass as required. The rest of the units are preferably kept as defaults.

Figure 4: Importing the mesh (2)

4. The imported mesh needs to be set as an acoustic mesh to carry out the acoustic analysis.
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Set as acoustic part as shown in Fig.5

Nodes and Elements → Expand → (mesh-file-name) → RMB → Set Mesh part Type → Set as

Acoustical Mesh Part

Figure 5: Setting as Acoustic mesh

5. Define acoustic material with properties Sound Velocity and Mass Density

Materials → RMB → New Materials → New Fluid Material

A new window shows up to input the valus of sound velocity and mass density as shown in Fig.6

Figure 6: Creating an acoustic fluid material

6. The above created acoustic material needs to be assigned to the acoustic mesh. For this, a

new acoustic fluid property has to be defined.

Properties → RMB → New Acoustic Properties → New Acoustic Fluid Property

As shown in Fig.7, a small window pops up. The Application Region is the acoustic mesh and the

created material is applied in the Fluid Material selection.
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Figure 7: Assigning acoustic fluid material to acoustic mesh

7. Now Modal analysis has to be performed to know the contribution of the structure on the

sound field inside the car compartment. To perform modal analysis, we have to insert the Acoustic

Modes case.

Insert → Modal Analysis cases → Acoustic Modes case

As shown in Fig.8, a small window pops up for the specification of the boundary conditions.

Figure 8: Acoustic modal analysis (1)

8. After the Acoustic modes case was inserted, Acoustic modes case will present in the Analysis

Manager tree as shown in the Fig.9.

Acoustic modes case → RMB → Acoustic Modes Solution Set.1
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Figure 9: Acoustic modal analysis (2)

9. To check the maximum frequency level to which all the elements in the acoustic mesh are

valid, the following sequence has to be followed -

Acoustic Modes Solution Set.1 → RMB → Maximum Frequency Report

Then a window pops up as in Fig.10 showing the validity of various percent of elements for the

respective maximum frequencies.

Figure 10: maximum frequency report

10. To perform the modal analysis, solution parameters have to be selected as shown in Fig.11.

Acoustic Modes Solution Set.1 → RMB → Acoustic Modes Solution Set.1 object rightarrow Defi-

nition

11. After the selection of desired no. of modes or desired frequency range, the Acoustic Modes

Solution Set.1 has to be updated for the calculation of acoustic modes.

Acoustic Modes Solution Set.1 → RMB → Update

A job details window pops up as shown in Fig.12
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Figure 11: Job parameters for Acoustic modal analysis

Figure 12: Calculation of acoustic modes

12. To visualize the acoustic modes -

Acoustic Modes Solution Set.1 → RMB → Generate Image

A window will show up as in Fig.13 in which we have to specify the parameter to be displayed

and the mode to be visualized. 13. An Acoustic Mesh preprocessing set has to be included in the
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Figure 13: Visualization of acoustic modes

Analysis manager tree as shown in Fig.14 to perform Acoustic Response case which is required to

simulate the sound field due to the excitation from loud speakers.

Insert → Mesh Preprocessing set

After this an Acoustic Envelope will be created under the Nodes and Elements section and Acoustic

Mesh Preprocessing Set section will be created in the Analysis Manager tree. After this, all the

sections have to be updated.

Figure 14: Acoustic mesh preprocessing

14. The materials inside the car compartment should be given their impedance values as function

of frequency. These act as the boundary condition in the simulation of sound field. For this initially,

the materials of similar properties have to be grouped.
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Insert → Mesh grouping → Auto Update group

A window will show up asking on which basis the grouping should be done. Feature Angle was

selected as shown in the Fig.15

Figure 15: Mesh grouping (1)

15. Acoustic Envelope was selected as the input mesh part. An appropriate feature angle was

selected and the starting element was selected as shown in the Fig.16. In this manner all the required

parts should be grouped.

Figure 16: Mesh grouping (2)

16. Now Impedance as a function of frequency has to be applied to the grouped parts as shown

in the Fig.17

Property → RMB → New Acoustic properties → Absorbent panel property

17. To simulate the sound field due to the excitation from loud speakers Acoustic Response case

has to be included in the Analysis Manager tree as shown in Fig.18

Insert → Acoustic Response → Acoustic Response case

A window will show up as shown in Fig.18 asking the required information for the Acoustic Response
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Figure 17: Defining properties to mesh groups

case. Then Acoustic Response Case section will be added to Analysis Manager as shown in Fig.19

Figure 18: Inserting Acoustic response case (1)
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Figure 19: Inserting Acoustic response case (2)

18. Double click on Acoustic Response Case to expand the section. To add the acoustic sources-

Boundary Condition and Source Set → RMB → Acoustic sources → Monopole

Then a pop up will come asking the location and amplitude of the source as shown in Fig.20

Figure 20: Inserting acoustic source (1)

19. The amplitude value of the monopole source can be given either as a constant or a function

of frequency. To give amplitude as a function of frequency -

Check the Frequency dependent option → RMB → New

Then a window will be shown up as shown in Fig.21 in which frequency dependent input to the

source can be given.

20. To give the location of the speaker, mesh node or CAD point or co-ordinates of the desired

location of source are to be given as shown in the Fig.22
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Figure 21: Giving frequency dependent input to acoustic source

Figure 22: Giving location to acoustic source

21. The Load condition should be activated and the Source assignment should be done. These

options should be double clicked and options has to be followed as shown in the Fig.23

22. The modal analysis data was provided to the Mode Set in Acoustic Response case as shown

in the Fig.24
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Figure 23: Load condition and Source assignment

Figure 24: Providing Modal analysis data to Acoustic response case

23. Vector Output Set was defined on the entire acoustic mesh region as shown in Fig.25

24. Update all the subsections of Acoustic Response case. At last double click on Acoustic

Response Solution Set and edit the solution parameters as shown in Fig.26
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Figure 25: Defining Vector output set

Figure 26: Editing solution parameters of Acoustic Response case

25. Now update the Acoustic Modal participation Factors. A job details window will show up as

shown in the Fig.27

26. A Vector to Function Conversion case is inserted by - Insert → Pre- and Post- processing

→ Vector to Function Conversion case.

A window will show up asking the input details for the Vector to Function Conversion case as show

in the Fig.28
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Figure 27: Job details of Acoustic response case

Figure 28: Job details of Acoustic response case

27. The Load Condition has to be updated as mentioned in the Step 18. Now Output Field

Points for Acoustic Functions have to be selected. These points have to be selected from the

Acoustic Envelope that is created in the Step 13. For feasibility of selecting the desired points, hide

the Acoustic mesh and make only Acoustic Envelope visible as shown in Fig.29

Nodes and Elements → Double click → Acoustic mesh → RMB → Hide/Show

28. Now nodes has to be created at the desired points inside the car interior where we want the

results. Here, the nodes has to be created at the left and right ears of the passengers as shown in

the Fig.30

Output Points → Double click → Single Point Selection → Select the desired node from the mesh
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Figure 29: Defining Vector output set

Figure 30: Selection of Output points

29. All the subsections in Vector to Function Conversion case have to be updated and at last

the Load vector to Function Conversion case has to be updated.

Load vector to Function Conversion case → RMB → New Function Display

Pop ups will appear as shown in the Fig.31

30. A new window appears asking to select the point of interest to display the curve. The format

of data can be modified by right clicking on the axis name of Y- axis (here, dB(RMS)) and the range

of frequency can be modified by right clicking on the axis name of the X-axis.
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Figure 31: New function display

Figure 32: Selection of data for displaying

Figure 33: Pressure distribution as a function of frequency
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Appendix I:

High frequency analysis of the acoustic simulation of sound field inside the

car passenger compartment

1. Open LMS Virtual.Lab. Select the Ray Tracing Acoustics License as shown in the Fig.34 Tools

→ Options → General → LMS Licensing → Ray Tracing Licence

Figure 34: Selecting Ray Tracing Acoustics license

2. Start the Ray Acoustics module. This will create a new analysis window with a pre-defined

tree.

Start → Acoustics → Acoustic Ray Analysis

3. Import the surface mesh of the desired car model with a compatible mesh file format.

Links Manager → Right Mouse Button → Import

4. Group the materials of similar properties inside the car compartment and give them impedance

boundary condition as a function of frequency as mentioned in the Steps 14, 15 and 16 as mentioned

in the Appendix H.

5. Create Field Point Meshes in front of the passenger seats as shown in Fig.35

Insert → Field Point Meshes → Plane Field Point Meshes

A window will pop up asking the dimensions of the mesh and no. of divisions of the mesh. The

mesh should be divided in such a way that a node should come at the location of the passenger’s

head. Two field meshes should be created: one for front passengers and the other for rear passengers

as shown in Fig.36
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Figure 35: Creating field point meshes

Figure 36: Field point meshes

6. Acoustic source should be provided for the simulation of sound field. The acoustic sources are

inserted into the Analysis Manager as shown in Fig.37

Insert → Acoustic ray Sources → Acoustic Ray Source Set

Figure 37: Inserting Acoustic ray source set

7. Point sources were provided at the loudspeaker locations as shown in the Fig.38

Acoustic Ray Source Set → Acoustic Ray Sources → Point Ray Source

8. A window will be shown up as shown in the Fig.39 asking the input conditions of the Point

source. Amplitude to the Point source can be given as a function of frequency as mentioned in Step

19 of Appendix H. A mesh node at the point of location of the Point source has to be selected as

mentioned in the Step 20 as mentioned in Appendix H.
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Figure 38: Inserting Point sources

Figure 39: Point ray source addition

9. New I/O set has to be inserted and input points have to be selected on the field mesh at the

location of the passenger’s head as shown in the Fig.40

Insert → New I/O Set Now the input points at the locations of the heads of four passengers can be

selected as mentioned in the Step 28 of Appendix H.

10. Create an Acoustic Field Response Analysis Case.

Insert → Acoustic Ray Analysis cases → Acoustic Ray Field Response Case and choose Acoustic

Ray Source Set as shown in Fig.41

11. Double click the Acoustic Ray Field Response Solution Set. In the Result Specification tab,

specify the frequency range as 1000Hz to 8000Hz in steps of 20Hz as shown in Fig.42. The Store

level specified as No Transient.
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Figure 40: Input points at passenger heads on the field mesh

Figure 41: Insert Acoustic ray field response case

Figure 42: Result specifications

12. In the Solving Parameters tab, the parameters are defined as no. of rays = 10000, reflection

order = 10, time window (ms) = 50 and dynamic range (dB) = 90 as shown in the Fig.43

13. To launch the computation the Acoustic Ray Field Solution Set has to be updated. Then
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Figure 43: Solving parameters

the job details window pops up as shown in the Fig.44

Acoustic Ray Field Solution Set → RMB → Update

Figure 44: Job details

14. Update all the subsections in the Acoustic Ray Field Analysis Case. Check for the existence

of Siva-505647-Acoustic.sdb file or a similar one under the Links Manager as shown in the Fig.45

Figure 45: Existence of .sdb file under Links Manager

15. Now check the result of the performed simulation.

Acoustic Ray Field Response Solution → RMB → Generate Image → SPL(dB) → OK

16. To plot the Spectral Function in one field point -

Spectral Function Set → New Function Display → Select 2D Display/Bode Plot → Select required

point for display
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Figure 46: Contour plot of SPL(dB) in the field meshes

Figure 47: Spectral function in two field points

17. Use Post-processing tab of the Select Data dialog to transform to time domain as shown in

the Fig.48

18. Now insert another Acoustic Ray Field Response Analysis Case as mentioned in the Step 10.

19. Double click the Acoustic Ray Field Response Solution Set and in the Result Specifications

tab, specify the frequency range as 1000Hz to 2000Hz in steps of 20Hz. Define the Store Level to

Full STI. Switch to Binaural Synthesis option. Use audio file in Free-format The FieldPoint View

Angle indicates the viewing direction of the binaural heads at each field point location. It is always

measured from the positive X-axis. If we put FieldPoint View Angle equal to -180 as shown in the
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Figure 48: Inverse Fourier Transform

Figure 49: Insert Acoustic ray field response case

Fig.50. This means that the binaural heads are looking in a direction opposite to the global X-axis.

The Result Specification were made as shown in the Fig.51

19. The Solving Parameters were maintained as mentioned in the Step 12.

20. To launch the computation update the Acoustic Ray Field Solution Set. After the compu-

tation was done check for the existence of Siva-505671-Acoustic.sdb or similar file attached to the

Links Manager as shown in the Fig.52

21. Also look for the existence of BIR11537.txt, BIR11506.txt, BIR11517.txt and BIR11491.txt

files in the working directory of the server. These contain the BIRs of the response field points.

Update all the sections under Acoustic Ray Field Response Solution Set.

22. Plot the Interaural Cross Correlation (IACC) by following the sequence as shown in the
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Figure 50: Field point view angle equals −1800

Figure 51: Result Specifications

Figure 52: Checking for .sdb file under Links Manager

Fig.53

Overall vector Set → RMB → Generate Image → Interaural Cross Correlation → Ok
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Figure 53: Generating IACC plot

Figure 54: Inter Aural cross Correlation at all the four seating positions in car compartment

23. In the similar way, Initial Time Delay Gap (ITDG) and Binaural Quality index (BQI) can

also be plotted.
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